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Important Notice

We have done the utmost to make certain that the data that appears on tax
forms produced by the Club Tax Printer software is correct as based on the
data in your current Investment Club Accounting files. Nevertheless, we do
not warrant the accuracy or completeness of the data on the printed tax
forms. All responsibility for accuracy and completeness rests with your in-
vestment club and with the person who handles the tax matters for your club.
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Important: IRS Partnership Return Deadline

The deadline for filing partnership tax returnsto the IRSis M arch 15th of each year.
March 15th isalso the deadline for providing partners with their Schedule K-1s. M any
states have adjusted their partnership filing deadlines as well, so be sureto check
with your state to ensure that you meet their required filing date. If allowed,
partnerships may file for an extension of the filing deadline using the appropriate
form for their state. Members of your club should not file their personal returns until
they have received the appropriate information from the club.

Using the Club State Tax Printer

This Club State Tax Printer program works by reading your Club Accounting data,
performing certain calculations, and generating your tax forms. The program does not
alter the data stored in the Club Accounting software. To properly use this program,
your accounting records must be up-to-date. We recommend running the year-end
wizard (if using CA3) and the Club Federal Tax Printer before preparing your state
tax return.

System Requirements
Use of the Club State Tax Printer software requires:

For Club Accounting 3 (CA3) For mylCLUB.com

- Compatible Windows operating system - Current generation web browser
(Windows 7/8/10). (Internet Explorer, Microsoft Edge,

- 256 MB of RAM minimum. Google Chrome, Mozilla Firefox,

- 30 MB of free hard drive space. Apple Safari).

- Adobe Acrobat 6.0 or higher, available - Internet access.
free from www.adobe.com. - Adobe Acrobat 6.0 or higher,

- Club Accounting version 3.2 or higher. available free from www.adobe.com.

- Current Accounting Maintenance - Current mylCLUB.com subscription
contract.

Installing the Club State Tax Printer
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There are different installation options for installing the Club Tax Printer, depending on
whether you use Club Accounting 3 or mylCLUB.com:

1. If you have purchased the CD version of Club State Tax Printer for CA3, insert it
into your computer’s CD-ROM drive and follow the prompts. Once the installation
is complete, close and re-open CA3.

2. If you have purchased the downloadable ver sion of the Club Tax Printer for CA3,
download it from www.iclub.com/taxes/download/. Save the installer to your com-
puter desktop. Once the download is complete, double-click on the Club State Tax
Printer Setup icon and follow the prompts. Once the installation is complete, close
and re-open CA3.

You do not need to download the installer onto the same com-

P puter on which you run Club Accounting 3, but can download it
onto any computer. Use a thumb or flash drive to transfer the
installer to the CA3 computer, and install the Tax Printer. Try this
approach if you have a slow Internet connection or have trouble
downloading the installer.

3. If you purchased the Club State Tax Printer for myl CLUB.com, thereis no
installation needed. Visit the Taxes tab of myl CLUB.com and click the button
to run the program.

Running and Registering the Club State Tax Printer

The Club State Tax Printer for CA3 is not a separate program, but an add-on to the
program. Select Taxes from the CA3 menu to run the tax module.

When starting the Club State Tax Printer for CA3 for the first time, you will see the
registration window. You must register your program over the Internet with your Tax
Printer serial number beforeit isusable. Y our serial number is proof that you purchased
alicense to use this program and is included with your Tax Printer packaging.

If you purchased the downloadable version of this program, your Tax Printer serial
number is provided via email and in your order receipt.

If you have multiple clubs licensed in your CA3 software, you will select the club from
alist presented when you start the program. If you would like to generate tax forms for
several clubs, you will need to purchase a Tax Printer serial number for each club from
www.iclub.com/taxes/.

No registration is required for the Club State Tax Printer for mylCLUB.com. Visit
the Taxes tab of mylCLUB.com and click the button to generate, print, and download
your tax returns.

Special Note for Clubs in MA, NJ, and WI

Investment club partnerships in Massachusetts that meet any one of the following
criteriamust by law file electronically (E-FILE) and cannot use the ICLUBcentral Club
State Tax Printer to submit a paper return (however, you may use the program to gen-
erate the input for the return and associated schedules).
Have 25 or more partners (as determined by number of Schedule K-1s at the
federal level or Schedule 3K-1s at the state level)
Have more than $50,000 in gross income (sum of interest, dividend, and other
income)
Have more than $100,000 in stock sale proceeds (gross sal es proceeds, not taxa-
ble capital gain).
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New Jer sey investment clubswith 10 or more member s (as determined by the number
of Schedule K-1 forms at the Federal level) must file their NJ-1065 over the I nternet
at the NJ state tax website. There are a significant number of calculations required to
generate the input for the NJ-1065 return and associated schedules. The NJ Club State
Tax Printer will make these calculations for you and prepare a full return which you can
then transcribe to the web based forms.

Partnerships in Wisconsin must file electronically unless a waiver request has been
approved by the state. A sample waiver form will be generated by the Club State Tax
Printer which must be submitted according to the instructions. Once approval has been
received, the club may submit the paper forms generated by the program.

Preparing the Club Data

Note: Skip this step if you have already finalized your tax returns using the Club Fed-
eral Tax Printer.

Before generating tax forms, make sure that your accounting data is properly prepared.
We recommend that you wait until you have all necessary data and have performed a
reconciliation of all partnership accounts before completing your taxes. Necessary data
includes your year-end brokerage and bank statements; all buys, sells, dividends, interest,
and service charges through December 31; and Form 1099s issued by your financial insti-
tutions. It islikely that you will not have thisinformation until mid-February.

We recommend that you view the “Closing the Books at Year-
End” webinar video available in the Learning section of
ICLUB.com for complete year-end procedures.

Once you have all the necessary data and the club has conducted its annual audit, close
out the books for the year, including creating a year-end Valuation Statement and Allo-
cating Income and Expenses for the year.

Users of Club Accounting 3 may close the books by following the instructions in the
year-end task wizard available under Tools > Year-end Tasks.

About Draft and Final Forms

The Club State Tax Printer software is often distributed before final forms have been
released by states. When you initially install the program, it may display preliminary
forms with a “DRAFT” watermark. Draft forms may not be used to file a return
with your state. They are provided so that you may get a head-start on the preparation
of forms, diagnose any technical problems, and ensure that your tax printer and club
accounting software are working properly.

The Club State Tax Printer for myl CLUB.com is updated automatically whenever
a new version is available. Whenever you run the program from the Taxes tab, it is
the most current release.

The Club State Tax Printer for CA3 has an automatic updater built into the program.
Each time you start the Club Tax Printer, it will check the Internet to see if any up-
dates are available. Of course, you must be connected to the Internet in order for the
auto-updater to work. When an update is available, the program will download and
automatically install the new version.

To check the release schedule for state forms, please check the home of page of
www.iclub.com regularly through the tax season.
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Auto-Updating the Program with Final Forms

When an update to the Club State Tax Printer for CA3 is available, the program
will prompt you to automatically download and install it. When final forms are re-
leased, they will be delivered to your computer via this auto-updater.

If updates are available, you will be alerted to | 2016 TaxPrinter
how many are available and t.heil' gize. Click :);:;Q\IOa-mg applications should be closed before continuing the
Yes or OK to agree, and the dialog box to the | [icluscenal Bootsiapper

right will appear. Click OK to continue.

Automatically close applications and attempt to restart them after

When installing updates, you may find the | @ 7 compete

progress bar does not fill all theway before Do ot close appications. (A Reboot wil be required)
the updater gives the option to click OK. If ok ] [ coes

that happens, don’t worry; as long as the
OK button is clickable on the updater, your copy has installed the update.

The Club State Tax Printer for mylCLUB.com is updated automatically with final
forms behind the scenes, with no action required by users.

Entering Your Club Information

Once you have registered, you will see a screen listing the states which are included in
the Club State Tax Printer. Choose your state and click OK. On the following screens,
you will be prompted to enter information about your club needed to generate your
club’s tax forms. The specific questions and input required vary by state.

" We recommend that you view the “Preparing Club Taxes” webi-
@ nar video available in the Learning section of ICLUB.com for
complete details on the tax preparation process.

Please refer to the help files within the program for information that is relevant to your
specific state’ s tax return forms. If necessary, you may use the Club State Tax Printer
to complete the forms for more than one state for a single club.

Generating Your Tax Forms

Y ou are now ready to print your state tax return. Y ou should generate a complete return,
and then, if your state requires a schedule similar to the Federal Schedule K-1, copies
of this schedule for each member. Members of clubs using mylCLUB.com can click
the links in the Taxes tab to download and/or print their returns.

Check the appropriate boxes to print the main tax return and any additional schedules
(as appropriate for your state).

Create PDF Files. Selecting Finish will generate forms in PDF format and launch
Adobe Acrobat. From Adobe Acrobat, you can save or print your forms.

Print Your Tax Forms. To print forms, click on the printer icon or select the File >
Print menu item after you have generated your club’s tax return.

Save Your Tax Forms. To save tax forms to your computer, click on the disk icon or
go to the File > Save menu item. The files will be saved in Adobe’s PDF format. You
may read these at any time using the Adobe Reader.

Additional Notes. A “Partner’s identifying number” for each member is required for
the tax return to be complete. If the message “No Tax ID Entered” shows up next to a
member’s name, or that box is empty, that member’'s Social Security Number was not
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entered in the Club Accounting program. Y ou can edit each member’s profile to add the
number and then regenerate the forms, or you can add the numbers by hand to the paper
forms. If you choose to write in the numbers on the printed forms, note that the saved
PDF forms will not include Social Security Numbers, so saving a hard copy with the
numbersis preferred.

Select Quit to exit the Tax Printer.

What to Send to Your State Tax Agency. The Club State Tax Printer software prints
returns and schedules required for filing your club’s tax return in a format acceptable to
your state’s Tax Department. Instructions for what to send and where to send your return
can be found on the cover sheet printed with the return.

What to Give to Your Members. If your state requires, give each member a copy of
his/her state equivalent to Federal Schedule K-1. This schedule will be used in filing
their personal state tax returns. Individuals who withdrew from the club during the year
must also be provided with the appropriate forms.

What to Keep for Club Records. The club should keep a copy of the full state return,
all attached schedules, and any additional supporting statements and attachments as part
of its permanent records. We recommend keeping the electronic PDF files in addition to
paper copies.

Common Problems and Release Notes

The Club State Tax Printer for CA3 requires registration before the program can
be run. Registration is done over the Internet from the registration screen.

If you find the program taking along time to load and/or print your Adobe Acrobat
Reader and tax forms, your computer or printer may lack sufficient memory. Select
fewer forms to print, then repeat the process.

Links to forms and instructions are found in the program'’s help section.

The 2017 Club State Tax Printer software uses Adobe Acrobat to generate your
tax forms. A free copy of Adobe Reader installs with the tax program, and can also
be downloaded from www.adobe.com.

Answers to Frequently Asked Questions

For more information about club tax filing, using the Club Tax Printer, and year-end
accounting tasks, we suggest that you first use our Frequently Asked Questions (FAQ)
searchable database available at www.iclub.com/fag/. The answers to the most common
questions will likely be found here.

For additional help, please refer to the following pages on the ICLUB.com web site:

Club Tax Printer Product Info www.iclub.com/taxes/
Frequently Asked Questions www.iclub.com/fag/
Club Tax Principles www.iclub.comv/support/genera_tax_principlesasp
Understanding Club Tax Season www.iclub.com/support/tax_season.asp
Download Club Tax Printers www.iclub.com/taxes/download/
Investment Club Learning Center www.iclub.com/clubsiiclub_hub.asp
Free Club Webinars www.iclub.com/clubs'webinar_information.asp

Requesting Technical Support from ICLUBcentral:

Each year, your club’s members look to you to make sure their taxes are filed in time.
And each year, from December to March, ICLUBcentral’s call volumes triple. We
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bring in extra help, update the FAQs, and give it our all to answer your questions.
Y our patience is appreciated. Here's looking forward to a successful tax season!

Technical Support is available on our web site at www.iclub.com/support/. You may
ask specific questions via our web form and review the Frequently Asked Questions
section of the web site at www.iclub.com/fag/ as well.

Answers to questions about Club Tax Printer installation are

included with your purchase of the software. Questions about
club accounting principles, tax issues, and the Club Account-
ing 3 software are covered by your Club Accounting Software
Maintenance Agreement. To receive full coverage, you must
renew your Agreement each year.

If you cannot solve your problem using the Frequently Asked Questions tool at
www.iclub.com/fag/, the most efficient way to contact an |CLUBcentral Technical
Support Representative is to use our web help system located at
www.iclub.com/support/. Our experts will be able to retrieve and reply to your ques-
tion quickly and efficiently.

Use the guide to help our experts quickly answer your questions. Write down the
precise wording of any error message displayed when you have a problem, including
the names of any files mentioned in the message. Be familiar with:

The version of Windows you are using.

The amount of memory (RAM) on your computer.

The make and model printer if you have a question regarding printing.

Any security, firewall, or antivirus software running on your computer

(Kaspersky, McAfee, Norton, etc.).

Y our Club Tax Printer serial number and purchase/installation date.

User License and Support Agreement (ULSA)

Use of this product is governed by terms of a User License and Support Agreement
or UL SA provided in the program upon use and installation. This License and Support
Agreement is alegal contract between your investment club or you in your individual
capacity, as the case may be, and ICLUBcentral Inc. By clicking on “accept” when
you install the software, you are agreeing to be bound by the terms and conditions of
this agreement, including without limitation the customer support provisions set out
in the agreement.

If you do not agree to such terms and conditions, you must promptly return the soft-
ware to ICLUBcentral in order to receive arefund. For more information, please write
to ICLUBcentral at 711 W. 13 Mile Rd., Madison Heights, M| 48071.

About ICLUBcentral Inc.

ICLUBcentral Inc. is the global leader in the development of software tools for invest-
ment clubs. We have been making club accounting and tax software since 1989, and our
products are used by more investment clubs than any other in the world.

Besides Club Accounting 3 for Windows and mylCLUB.com (www.myiclub.com),
ICLUBcentral also produces:

Softwar e programs for stock analysis, including Toolkit 6;
Newsletter s such as the market-beating I nvestor Advisory Service
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(www.investoradvisoryservice.com); and the SmallCap I nformer
(www.small capinformer.com);

Onlinetools including a stock screener, MyStock Prospector.com
(www.mystockprospector.com); a complete suite of online tools, data, and
community for investors, StockCentral.com (www.stockcentral.com); and an
advanced stock research tool, EquityResear chSer vice.com
(www.equityresearchservice.com).

For details and special offers for you and your investment club members, please visit
www.iclub.com.

A Special Note for Users of Club Accounting 3

Asmost usersare aware, Club Accounting 3'slifecycleisnearing its end. While
we will continue to support the program for the foreseeable future, ICLUBcen-
tral may not provide support for the Club Tax Printer for CA3 users after this
year. As such, we recommend that investment clubs switch to our cloud-based
club accounting platform, mylCLUB.com before it istoo late.

Switching to mylCLUB provides a number of advantagesthat will save you
money and streamline club management tasks. Some of the mylCLUB.com
features not available in Club Accounting 3 include:
- e-Fileyour club’sIRStax returns (new for 2017!).
Determine best methods of paying out partial or full member withdraw-
als with our Withdrawal Scenario Calculator.
See breakdowns of holdings by company size, industry, sector, and su-
per sector with Portfolio Diversification Reports.
Change treasurers easily just by adjusting permissions in your private
club website, with no data import/export required.
Protect your data with redundant, secure, and automatic cloud-based
backups.
Monitor club holdings closely with Stock Watcher Reports.
Save significantly with no upfront software cost, discounts for multi-
year subscriptions, and no additional charge for co-treasurers.
Store documents in your private, secure file storage library.
Get deep portfolio intelligence from more than 35 reports and graphs.
Find integrated help on each page.

To get started, our trained support team can migrate your club data to
myl CLUB.com and apply any remaining term on your existing Club Account-
ing 3 subscription towards your first year. Visit www.mylCLUB.com/switch/
for details, and move your club forward into the next generation of tools used
by thousands of investment clubs.
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